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ACEV-1A EVM

This user's guide describes the operation of the Texas Instruments Codec Control software and the
DAC3120 EVM. Codec Control provides a graphical user interface for supported Tl audio codecs. The
software is compatible with Microsoft Windows XP, Vista and Windows™ 7.

The information in a caution or a warning is provided for your protection. Read each caution and warning

carefully.
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1 Introduction
The Codec Control software is intended to facilitate evaluation of Tl audio codecs.
It includes a script interpreter, a block-diagram based graphical user interface, a register inspector and
supplemental features (for example digital filter calculator) depending on codec capabilities.
The DAC3120 EVM works together with the Codec Control software. It connects to a PC via USB and
enumerates as a USB class audio device. Once configured with the Codec Control software, the EVM
acts as a sound card which can play back audio from the PC.
2 Control Software
This chapter explains how to use the Codec Control software together with a Tl audio codec EVM.
2.1 Control Software
The Codec Control software exposes most features of a supported Tl audio codec EVM through an
intuitive graphical user interface.
NOTE: Before Windows on the PC can use the Tl audio converter EVM as a sound card, the EVM
must be configured (sampling rate, audio routing, internal amplifier settings etc.) with the
Codec Control software.
This will happen automatically once an EVM is detected by the Codec Control software
2.2 Installation
Download the Codec Control software (slac366.exe) from the Tl audio codec product folder at
http://www.ti.com and launch the program (double click on slac366.exe).
This file is a self-extracting archive. The default target folder is:
C:\Program Files\Texas Instruments\CodecControl
Click the Unzip button to complete the installation.
The Codec Control software is now available in the target folder. The name of the executable is
CodecControl.exe
To launch the CodecControl software, navigate to the target folder with the Windows Explorer and double
click CodecControl.exe.
2.3 Concepts

The CodecControl software presents a block diagram view of a supported Tl audio codec EVM.

The block diagram consists of active objects that can react to user input (for example switches or
amplifiers with variable gain that show a volume control on a mouse click event).

NOTE: Active Objects — Each active object will change color to red if the mouse cursor is above
the object. Clicking the object will trigger its function.

Some active objects are linked to control register(s) of the Tl audio codec. The Codec Control software will
update the appropriate register(s) whenever an active object is triggered. If a register that is linked to an
active object is changed via other components (for example the script interpreter or the register inspector),
the active object will change its state accordingly.

The Codec Control software will automatically detect a supported Tl audio codec EVM once it is
connected to a USB port of the PC.

If no Tl audio codec EVM is connected to the PC, the control software also supports an EVM simulation
mode, where it is possible to retrieve script commands based on user input within the block diagram.
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Simulation mode is only available, if no Tl audio codec EVM is attached to the PC. Choose File—New

EVM simulation... and select an EVM from the list of supported Tl audio codec EVMs.

2.4 EVM Window
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Figure 1. EVM Window

At the top of the EVM window is a tool bar with buttons to change between different use cases:

. ’ Full featured evaluation

. P Playback only
.0 Record only
. Touch Screen Only

Availability of each use case depends on the Tl audio codec EVM — some buttons may be grayed out,
indicating that the use case is not available (this does not mean that the use case cannot be implemented
for this Tl audio codec).

Each use case has its own initialization script, which will run if a use case is selected by clicking on one of
the use case buttons. The initialization script contains register settings for the Tl audio codec to configure
the device for a specific use case.

The toolbar contains a control that determines the zoom factor. Change the zoom by selecting the desired
zoom factor.

To move the block diagram, click on a blank area within the block diagram and drag the diagram with the
mouse.

At the bottom of the EVM window is a status bar that provides information about the state of the
communication between the control software and the Tl audio codec EVM. It also shows hints about
elements in the block diagram, for example the I2C™ page and register / bit location of a selected switch.
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24.1

2.5

251

Audio signal paths (both digital and analog) will change color from black once they are activated via
switches. This feature visualizes all audio paths and immediately highlights if a path is enabled.

Using Active Objects

Moving the mouse pointer over an active object will light up the active object (the color of the object turns
red).

For example, the Class-A/B HP Driver left amplifier active object will turn from its inactive state to its active
state when the mouse pointer enters the amplifier symbol:

Class-AB HP Driver E:;;{ass-ﬁ;fﬁ HP Ciriver
0dB to 908 0dB to 3dB

> | >
NN i =N

N B N f

Clicking the activated object will trigger its function. In the case of the amplifier active object, the function
is a volume control. Moving the volume control slider changes the volume setting of the amplifier (it is also
possible to change the volume by clicking onto the number within the amplifier symbol and typing the new
gain setting).The Codec Control software updates the appropriate register in the Tl audio codec and as a
result the volume on the headphone output will change accordingly.

___________ Zlass-AB HFE Driver
| 0dB to 8dB

Dialogs and Active Objects

The Codec Control software contains several dialog windows that give access to additional features.
Most dialogs are linked to active objects and are opened by clicking on the active object.

A few dialogs are not linked to active objects and are opened using the View menu.

Init Script Dialog

Each use case {:} e , i , &' owns a unique initialization script which will automatically run when a
supported Tl audio codec is detected or if the user selects another use case.

To show or edit the initialization script, choose View->Init Script... from the main window menu bar.
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Init Script: Codecs’ AIC3111_USBE_Init.kxt

Command Buffer:

+
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=/ reset

PLL_clkin = BCLE,codec_clkin = PLL_CLE

mode is ifs , wordlength is 16
NDAC is powered up and set to 4

MDAC i=s powered up and et to 4

DOSE = 122, DOSR{S:2)

Execute

n]

Click the Run button to run the script again. For further information about the script syntax, see Script

Syntax.

25.2 Command Dialog

Figure 2. Initialization Script

Open the command dialog (View—Command...) to write, edit, load, save and run command scripts.

Command scripts are text files that contain commands to communicate with the Tl audio codec. The

syntax is described in Script Syntax.
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Command Buffer: Read Data:

i"" Open r 30 28 04:
17 OF 10 1D

o
(=]
r
w
L]
-1

30 28 Ef u
Save

Run

44844444
[
=]
ra
w
"
.-n

0 08 17 ¥ Record

30 25 04

Clear

Figure 3. Command Dialog

The main area of the command dialog is the command buffer (editable text) which contains the
command script. To run the command script, click the Run button.

The smaller read only text area on the right side of the command dialog displays control data read
from the Tl audio codec. The Clear button clears the Read Data field.

The one line text edit field on the left bottom allows single command execution.
The Record check box enables recording of commands generated by the control software.

Figure 3 shows a recording of the volume control for the left Class-A/B HP Driver amplifier of a
TLV320AIC3111 (note that the Record checkbox is checked).

A single command to read four bytes starting at address 0x28 was executed and the result is displayed in

t

he Read Data field.

253 Register Inspector
The register inspector dialog (View—Register Inspector...) gives access to all registers of the Tl audio
codec.
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Register Inspector
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Figure 4. Register Inspector

The register inspector displays the content of the Tl audio codec registers. To trigger reading the content
of one page, click the Refresh button.

The Page edit field selects the page to be displayed.
The addr column shows the address of the registers within the selected page in decimal notation.
The description column contains a description for each register. If the register has no function
assigned, it is declared Reserved.
The data columns show the data of each register (one byte). The first data column uses decimal
notation, the second uses hexadecimal notation. It is possible to change the register value by clicking
into one of the data fields and typing the new value (either decimal or hexadecimal).
The numbered columns show the register content in binary notation. Read/Write bits are shown solid
black or red; read only bits are gray or dark red. Red numbers represent bits that recently changed. To
change a single writeable bit, click on the bit and it will flip.

254 DAC Filter

This tool is available for Tl audio codecs that include digital biquad filters.

SLAU302-December 2009
Submit Documentation Feedback

Copyright © 2009, Texas Instruments Incorporated

ACEV-1A EVM 7


http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU302

13 TEXAS
INSTRUMENTS

Control Software www.ti.com

TI Biquad Coefficient Calculator
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Figure 5. DAC Filter

» This tool displays the combined frequency response, the combined phase response and the individual
frequency response of multiple digital biquad filters (depending on the capabilities of the TI audio
codec).

Solid lines show the frequency response.

The dashed line shows the combined phase response.

Individual frequency response is enabled by checking the right check box in the Enable column.
e Zoom is available by holding Ctrl and drawing a zoom window with the left mouse button or

dynamically zooming the gain range with the right mouse button.

To cancel zoom, click the right mouse button while not pressing any key.

» Each biquad has its own unique handle with a unique color. To change the frequency and gain of a
biquad, grab and drag its handle.

« Each biquad can be configured for parametric EQ, Shelf (Bass and Treble), High Pass, Low Pass,
Phase Shift, Notch.

» Some filters (for example High Pass filter) have sub-types that can be selected by the SubType
column.

» Due to digital range limitations, the biquads will automatically scale, if the biquad coefficients exceed
the limitations.

The coordinate system will shift accordingly to reflect the resulting attenuation.

» Coefficients are automatically sent to the Tl audio codec — the filter response can be verified in
real-time.

» Some filter parameters may lead to unstable filter

CAUTION
If the filter becomes unstable, loud noise may occur.

» To retrieve the biquad coefficients, click the Coeff button. This will open a window with the biquad
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coefficients:
Coefficients §|

R.esolution: Bits lal Save

Text "* Sample Rate = 44100"

Texk "* Filker 1 Bass Shelf 147 Hz Fc 6.2 dB"

Text "* Fiker 2 EQ 8641 Hz Fc 4.1 dB 5425 Hz Bw"
Text "* Filker 3 EQ 1718 Hz Fc 3.9 dB 343 Hz BW"
Text "* Hz) = (MO + 2*N1Jz + N2/(z2)) | (32768 - 2*D1/z - DEfz20"
Text "* Filker Coefficients in format MO, M1, N2, D1, D2"
Tewxtk "* Filker 1"

0xFFFF

Ox824C

0x7BTE

0x7EGS

0x532E

Textk "* Filker 2"

0x7FFFF

0xE&35

0x1AD9

0x1E4F

OxCADE

Textk "* Filker 3"

0x7FFFF

Ox8564

0x7e94

%7936

Ox8620

Figure 6. Filter Coefficients

The coefficients may be used for a customer’s filter implementation. The format is compatible with the TI
audio codec that was detected by the Codec Control software.

2.6 EVM Applications

Some Tl audio codec EVMs contain an EEPROM that can store EVM applications, for example:
*  miniDSP applications

 Initialization scripts

« Parameter patch scripts

The CodecControl software contains a browser to access the applications stored in the EEPROM. To
access the browser, select File->EVM Applications...
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E¥M™ Applications

- = MainInik
'i ALC3111_USE_Inik

................................. Comrands: 0 EEPR.CM: 0 Bytes

Length; ] Bvkes Image: 299 Bvtes

Figure 7. EVM Applications

Applications stored in the EEPROM are listed in a tree view.

To add an application, choose Add Application from the context menu (right mouse click within the tree
view).

To change the name of an application, select the application, single click on the application and type the
new name.

Each application owns one or several scripts. The scripts consist of a sequence of commands that
program the Tl audio codec (or EVM components). Examples are initialization scripts or miniDSP
programs.

To add a script to an application, choose Add Script from the context menu. Double click on the script to
open a command window. The command window has an open button to choose a script via a file dialog or
alternatively it is also possible to write the script within the command window.

Some TI audio codecs have on or more push buttons that select an application or a script within an
application. Please refer to the EVM user’s guide for further information about how to select applications
and scripts for a specific EVM.

Click Update EVM to program the EEPROM.

Scripts are stored in a compiled binary format on the EEPROM and cannot be read back. A red lock next
to the application name highlights scripts that reside in the EEPROM but can not be viewed in the
command window.

To change the sequence of scripts or applications, drag a script or application to the new position.

2.7 Firmware Update
Tl may publish new firmware for Tl audio codec EVMs in the future. To program a new firmware to a Tl
audio codec EVM, choose File—Update Firmware... and select the new firmware file.
The update process takes a few seconds (there is no progress bar) and will be finished once the update
firmware dialog disappears.
The EVM must be disconnected and reconnected to complete the firmware update process.
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2.8 Script Syntax

A script is a text file that contains data to send to a device.

Each line in a script file is one command. No provision is made for extending lines beyond one line, except
for the > command. A line is terminated by a carriage return.

The first character of a line is the command. Commands are:

Read from the serial control bus
Write to the serial control bus
Extend repeated write commands
Comment

Set interface bus to use

Break

Delay

Wait for Flag

# Vs -

- 0 o —

Command: r <address> <register> <length>

<address> is the device address in hexadecimal format. For example 30 for device address 0x30.
<register> is the register in hexadecimal format that will be read from.

<length> is the number of bytes that will be read from <register> in auto-increment mode.

The result will be displayed in the right-side output window of the command interpreter dialog.

Command: w <address> <register> <data ...>

<address> is the device address in hexadecimal format. For example 30 for device address 0x30.
<register> is the register in hexadecimal format that will be written to.

<data...> is a sequence of bytes that will be written to the <register> in auto-increment mode. Each
byte is in hexadecimal format.

Command: > <data ...>

This command continues a write sequence in a new line.

<data...> is a sequence of bytes that will be written in auto-increment mode. Each byte is in
hexadecimal format.

Command: # [optional comment]

This command indicates a comment.

Command: i<interface>

<interface> is i2c for 12C or spi for SPI

Command: b[optional comment]

[optional comment] is a string of characters. The command interpreter will show a modal dialog with
the optional comment. Script execution will resume once the dialog is closed.

Command: d<time>

This command suspends script execution by at least <time> milliseconds.

Command: f <address> <register> <mask> [optional timeout]

This commands suspends script execution until the value read from <address> <register> matches
<mask>

<address> is the device address in hexadecimal format. For example 30 for device address 0x30.
<register> is the register in hexadecimal format that will be read from.

<mask> is a 8-bit binary format mask that is compared with the data from the device. Each bit can be
0, 1orX.

For example: <mask> = 010XX01X tests, if the data from the device has D7=0, D6=1, D5=0, D4=don’t
care, D3=don’t care, D2=0, D1=1, DO=don't care.

SLAU302-December 2009 ACEV-1A EVM 11
Submit Documentation Feedback

Copyright © 2009, Texas Instruments Incorporated


http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU302

13 TEXAS
INSTRUMENTS

DAC3120 EVM www.ti.com

3.1

3.2

3.3

[optional timeout] specifies how long (milliseconds) the command interpreter will poll the device if the
data doesn’t match the <mask>

DAC3120 EVM
This chapter contains information about the DAC3120 EVM

Overview

The DAC3120 evaluation module is an easy to use, small form-factor system that allows access to all
features of the DAC3120 via a USB interface and a PC running the CodecControl software.
It consists of:
 DAC3120 codec
* Headphone output
» Class-D speaker terminals
e Microphone input
e Analog volume control
» USB interface
* User interface
— LEDs
— Buttons
» Control interface test points
» Digital audio interface test points

Getting Started

To get started with the DAC3120 EVM:

» Install the CodecControl software (see 2.2).
» Launch the CodecControl software.

e Plug a headphone into J4.

» Connect the EVM to the PC via a mini USB-B to USB-A cable. The CodecControl software will
automatically detect the EVM and run an initialization script, which will configure the DAC3120 EVM for
audio playback through the headphone jack.

* Play music with any Windows application (e.g. Windows Media Player, YouTube, iTunes...)

EVM Applications
The DAC3120 EVM supports multiple EVM applications that can be stored in the on-board EEPROM.

SW2 cycles through applications. LED D1 indicates, which application is active by blinking N times when
SW1 selects application #N.

SW3 cycles through patches. LED D2 indicates, which patch is applied by blinking N times when SW2
selects patch #N

The first application (if present) is the boot application — the boot application contains a script that is
intended to initialize the DAC3120. It will be skipped by SW1.

The first script of each application contains the application itself. Subsequent scripts of each application
other than the boot application are loaded as patches to the application each time SW2 selects a patch.

It is possible to program complex use cases to the EVM and execute them without having to run the
CodecControl software.

A simple example is to program the DAC3120 initialization script from the CodecControl software to the
boot application. Afterwards, the EVM acts as a USB sound card without requiring the CodecControl
software.

12
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331

3.4

miniDSP Programs

miniDSP programs developed in Tl PurePath Studio can be programmed as EVM applications using the
CodecControl software. A miniDSP program must be exported from PurePath Studio as a command script
and loaded with CodecControl as described in 2.6

Jumpers, Connectors, Test

W1:

W2:
W3:
W4
WS5:
WE6:
WT7:
W8:

TP1:
TP2:
TP3:
TP4:
TP5:
TP6:
TP7:
TP12:
TP13:
TP14:
TP15:

1-2: Select analog volume control potentiometer.
2-3: Select microphone detection.

insert to apply right channel mic-bias voltage to microphone connector.
insert to apply left channel mic-bias voltage to microphone connector.
AVDD wire loop. Cut and insert ampere meter to measure AVDD current.

SPVDD wire loop. Cut and insert ampere meter to measure SPVDD current.
HPVDD wire loop. Cut and insert ampere meter to measure HPVDD current.

DVDD wire loop. Cut and insert ampere meter to measure DVDD current.
IOVDD wire loop. Cut and insert ampere meter to measure |IOVDD current.

I2C SCL

12C SDA

MCLK for codec

[2S™ DIN to codec
I12S BCLK

I12S DOUT from codec
12S WCLK

Reset

GPIO1 from codec
GND

TP8, TP9, TP10, TP11, TP12: Not used by DAC3120

J1:
J2:
J3:
J4.

SW1:
SW2:
SW3:

mini USB-B connector
Microphone input
Class-D speaker terminal
Headphone output

Reset codec
Select EVM application
Select patch script
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THIS SCHEMATIC PERTAINS

ACEV-1B_RHB_USB_EVM_REVB

TO THE FOLLOWING DEVICES EEPROM oo
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o' 24FCa 2 15N orabay L
AIC3111 - (STEREO CLASS-D) 8 0402 GND
EDGE NUMBER: 6511728 7 B +3.3V
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EDGE NUMBER: 6511729 0603
oo S0IC8-SM R9
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EDGE NUMBER: 6511730 2.7K/5% TP1
0603 ?
AIC3100 - (STEREO CLASS-D) Whie seL 120
EDGE NUMBER: 6511731 J) SDA
White
DAC3120 - (MONO CLASS-D) Y en >
EDGE NUMBER: 6511733 1 v 5 —|0.1B§i6|gav—_|;
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EDGE NUMBER: 6511734 A ?
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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

Tl warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI's standard
warranty. Testing and other quality control techniques are used to the extent Tl deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.

Tl assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using Tl components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.

Tl does not warrant or represent that any license, either express or implied, is granted under any Tl patent right, copyright, mask work right,
or other Tl intellectual property right relating to any combination, machine, or process in which Tl products or services are used. Information
published by Tl regarding third-party products or services does not constitute a license from Tl to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from Tl under the patents or other intellectual property of TI.

Reproduction of Tl information in Tl data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. Tl is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.

Resale of Tl products or services with statements different from or beyond the parameters stated by Tl for that product or service voids all
express and any implied warranties for the associated Tl product or service and is an unfair and deceptive business practice. Tl is not
responsible or liable for any such statements.

TI products are not authorized for use in safety-critical applications (such as life support) where a failure of the Tl product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
and any use of Tl products in such safety-critical applications, notwithstanding any applications-related information or support that may be
provided by TI. Further, Buyers must fully indemnify Tl and its representatives against any damages arising out of the use of Tl products in
such safety-critical applications.

Tl products are neither designed nor intended for use in military/aerospace applications or environments unless the Tl products are
specifically designated by Tl as military-grade or "enhanced plastic." Only products designated by TI as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of Tl products which Tl has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.

Tl products are neither designed nor intended for use in automotive applications or environments unless the specific Tl products are
designated by Tl as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, Tl will not be responsible for any failure to meet such requirements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:
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